REN ESAS Application Note

R-IN32M3 Module (RY9012A0) RIOAN0400EJ0105
RL78/G14 Sample Application (UGOAL Edition) May.31.2024

Introduction

This document describes sample application software for RL78/G14 to perform industrial Ethernet
communication as host CPU of the R-IN32M3 Module (RY9012A0).

Target Device
RL78/G14
R-IN32M3 Module (RY9012A0)
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R-IN32M3 Module (RY9012A0)

RL78/G14 Sample Application (UGOAL Edition)

List of Abbreviations and Acronyms

In this document, the terms below are defined as follows:

Terms Description

This board The target boards of the sample program described in this document, RL78/G14 Fast
Prototype Board and the adapter boards with R-IN32M3 Module (YCONNECT-IT-I-
RJ4501)

This sample The sample program for the host microcomputer that controls the R-IN32M3 Module
in the industrial network sample program for the R-IN32M3 Module.

API Application Programming Interface

GOAL/uGOAL Generic Open Abstraction Layer

See "R-IN32M3 Module (RY9012A0) User's Manual: Software (R17US0002ED****)”

Related documents

Document Type

Document Title

Document No.

Data Sheet R-IN32M3 Module Datasheet R19DS0109ED****
User’s Manual R-IN32M3 Module User’s Manual: Hardware R19UHO122ED****
User’'s Manual R-IN32M3 Module User's Manual: Software R17US0002ED****
Application Note R-IN32M3 Module Management Tool Instruction Guide R30ANO390EJ****
Application Note R-IN32M3 Module Modbus TCP Start-Up Manual R30ANO406EJ****

User's Manual

Adaptor Board with R-IN32M3 module YCONNECT-IT-1-RJ4501 |[R12UZ0094EJ****

Application Note R-IN32M3 Module User’s Implementation Guide (uUGOAL R30AN0402EJ****
edition)

Quick Start Guide |RL78/G14 Fast Prototyping Board Quick Start Guide R20UT4571EJ****

User’s Manual RL78/G14 Fast Prototyping Board User’'s Manual R20UT4573EJ****

Application Note R-IN32M3 Module Software PLC Guide: TwinCAT R30ANO380EJ****
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R-IN32M3 Module (RY9012A0) RL78/G14 Sample Application (UGOAL Edition)

1. Overview

1.1 Abstract
This document describes the R-IN32M3 module sample software for RL78/G14 Fast Prototyping Board.
This sample software can communicate with major industrial Ethernet protocols such as PROFINET,

EtherNet/IP, and EtherCAT by running on RL78/G14 Fast Prototyping Board, which is evaluation board of
RL78/G14 MCU, connected with R-IN32M3 Module-based adapter board (YCONNECT-IT-I-RJ4501) via

Arduino™ connector.

Figure 1-1 R-IN32M3 Module + RL78/G14 Fast Prototyping Board
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RL78/G14 Sample Application (UGOAL Edition)

1.2 Operating environment

1.2.1 Software environment
The operating environment of this sample software is shown inTable 1-1.

Table 1-1 Operating Environments

of EtherCAT

Category Name Version Link Remarks
R-IN32M3 Sample Rev.1.05 Renesas R-IN32M3 Module https://www.renesas.
module package Sample Package
Sample
package
Integrated e2studio 2024-04 e? studio 2024-04 Windows|
development Renesas
environment
RL family GCC for V4.9.2.202201 - Included with e2studio
GNU Renesas
Toolchain RL78
Management ICE V1.5.1 - port industrial
Tool, simple automation GmbH
software PLC Including with Sample
Software PLC | TwinCAT V3.1 https://www.beckhoff.com/ Beckhoff Automation

R30ANO400EJ0105 Rev.1.05

May.31.2024

RENESAS

Page 6 of 72



https://www.renesas.com/us/en/document/scd/renesas-r-in32m3-module-sample-package-rev105
https://www.renesas.com/us/en/document/scd/renesas-r-in32m3-module-sample-package-rev105
https://www.renesas.com/r-in-module
https://www.renesas.com/r-in-module
https://www.renesas.com/document/uid/e-studio-2024-04-installer-windows
https://www.renesas.com/document/uid/e-studio-2024-04-installer-windows
https://www.beckhoff.com/en-en/products/automation/twincat/

R-IN32M3 Module (RY9012A0)

RL78/G14 Sample Application (UGOAL Edition)

1.2.2 Hardware environment

The operation of this sample software is verified with a hardware environment connected to the RL78/G14
MCU Group Evaluation Kit (RL78/G14 Fast Prototyping Board) with an adapter board equipped with an R-

IN32M3 module (YCONNECT-IT-I-RJ4501).

If you use RL78/G14 Fast Prototyping Board, you do not need to prepare the emulator separately for the
execution of this sample software because the emulator circuit equivalent to the E2 emulator Lite is built into

the board.

Also, this sample software includes multiple applications. Multi-protocol application and Remote 1/0
application can be executed by connecting the Digilent Pmod™ board in Table 1-2. For details, please refer

to Chapter 3.2.2.

Table 1-2 Hardware environments

Name Type Name Maker Link Note
RL78/G14 Fast | RTK5RLG140C | Renesas Electronics RL78/G14 Fast
Prototyping 00000BJ Corporation Prototyping Board
Board
Adapter Board YCONNECT-IT- | Renesas Electronics R-IN32M3-Module-
with R-IN32M3 [-RJ4501 Corporation Solution-Kit
Module
6-pin Pmod with | Pmod SWT Digilent, Inc. https://reference.digilentin | Multi-protocol
4-ch Switch (410-083) c.com/reference/pmod/pm | application,
odswt/start EtherCAT ID,
remote 1/0
application
6-pin Pmod with | Pmod LED Digilent, Inc. https://reference.digilentin | remote I/O
4ch LED (410-076) c.com/reference/pmod/pm | application
odled/start
R30AN0400EJ0105 Rev.1.05 Page 7 of 72
May.31.2024 RENESAS



https://www.renesas.com/products/microcontrollers-microprocessors/rl78-low-power-8-16-bit-mcus/rl78g14-fast-prototyping-board-rl78g14-fast-prototyping-board
https://www.renesas.com/products/microcontrollers-microprocessors/rl78-low-power-8-16-bit-mcus/rl78g14-fast-prototyping-board-rl78g14-fast-prototyping-board
https://www.renesas.com/jp/en/products/interface-connectivity/industrial-ethernet/multiprotocol-communication/r-in32m3-module-solution-kit-solution-kit-r-in32m3-industrial-ethernet-module
https://www.renesas.com/jp/en/products/interface-connectivity/industrial-ethernet/multiprotocol-communication/r-in32m3-module-solution-kit-solution-kit-r-in32m3-industrial-ethernet-module
https://reference.digilentinc.com/reference/pmod/pmodswt/start
https://reference.digilentinc.com/reference/pmod/pmodswt/start
https://reference.digilentinc.com/reference/pmod/pmodswt/start
https://reference.digilentinc.com/reference/pmod/pmodled/start
https://reference.digilentinc.com/reference/pmod/pmodled/start
https://reference.digilentinc.com/reference/pmod/pmodled/start

R-IN32M3 Module (RY9012A0) RL78/G14 Sample Application (UGOAL Edition)

2. Hardware configuration

The hardware configuration to run this sample software is described.

2.1 Adaptor Board Configuration

When using this sample software, set J13, J8, and J7 jumper blocks on the adapter board with R-IN32M3
module (YCONNECT-IT-I-RJ4501) as follows.

J13: Connect the Socket pin with the iRJ45 pin
J8: For the CS signal, select PB2
J7: For the RST signal, select PD7

Also, when using EtherCAT DC mode, short-circuit 3pin - 6pin and 4pin - 7pin of J10 with bridge wire.

"

J10

o

J8 Jr

Ether.CAT,
L Hodbus /TCP

| SrordT—— ’“""“J
— Ethernli_et/m

e e
LED1 LED2
RENESAS

Figure 2-1 Adaptor board with R-IN32M3 module

Plug the male Arduino connector on the back of the adapter board with R-IN32M3 module into the socket of
the RL78/G14 Fast Prototyping Board.

R30AN0400EJ0105 Rev.1.05 Page 8 of 72
May.31.2024 RENESAS



R-IN32M3 Module (RY9012A0)

RL78/G14 Sample Application (UGOAL Edition)

YCONNECT-IT-I-RJ4501

Figure 2-2 Arduino™ Connection
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R-IN32M3 Module (RY9012A0)

RL78/G14 Sample Application (UGOAL Edition)

2.2 Multi-protocol application

Multi-protocol (PROFINET, EtherNet/IP, EtherCAT and Modbus TCP) selector input in multi-protocol sample
application is confirmed by connecting the Pmod SWT to the upper stage (1-6pin) of the Pmod2 connector
on the RL78/G14 Fast Prototyping Board.

It is also used as the input switch of sample application software for Remote I/O, and the EtherCAT Explicit

Device ID.

Table 2-1 Connection of Pmod2 and Pmod SWT for Multi-protocol selector

PMOD?2 Upper RL78/G14 Fast Prototyping Board Pmod SWT
1 P16 Selector-ID1
2 P13 Selector-1D2
3 P14 Selector-1ID3
4 P15 Selector-1D4
5 GND GND
6 +3.3V VCC

YCONNECT-IT-I-RJ4501

RL78/G14 Fast Prototyping Board

Figure 2-3 multi-protocol selector Connection

R30ANO400EJ0105 Rev.1.05
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2.3 Remote I/O application

Sample application software for Remote I/O is confirmed in a configuration in which the switch input (Pmod
SWT) is connected to the upper of the Pmod2 connector (1-6pin) and the LED output (Pmod LED) is

connected to the lower (7-12pin) of the Pmod1 connector. (Figure 2-4)

It is also used as the selector input of sample application for multi-protocol, and the EtherCAT Explicit Device

ID.

Table 2-2 Connection of Pmod1 and Pmod SWT

PMOD?2 Upper RL78/G14 Fast Prototyping Board Pmod SWT
1 P16 SW1
2 P13 SW2
3 P14 SW3
4 P15 Sw4
5 GND GND
6 +3.3V VCC

Table 2-3 Connection of Pmod2 and Pmod LED

PMOD1 Lower RL78/G14 Fast Prototyping Board Pmod LED
7 P140 LEDI1
8 P130 LED2
9 P147 LED3
10 P146 LED4
11 GND GND
12 +3.3V VCC

Pmod LED R

Pmod1 (7-12pin)

RL78/G14 Fast Prototyping Board

YCONNECT-IT-I-RJ4501

Figure 2-4 Remote I/O Connection

R30AN0400EJ0105 Rev.1.05
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2.4 EtherCAT Explicit Device ID selector

EtherCAT Explicit Device ID selector input in this sample software is confirmed by connecting the Pmod
SWT to the upper stage (1-6pin) of the Pmod2 connector on the RL78/G14 Fast Prototyping Board.

It is also used as the selector input of sample application for multi-protocol, and the switch input of sample
application software for Remote 1/O.

Table 2-4 Connection of Pmod2 and Pmod SWT for EtherCAT ID

PMOD?2 Upper RL78/G14 Fast Prototyping Board Pmod SWT
1 P16 ECAT-ID1
2 P13 ECAT-ID2
3 P14 ECAT-ID3
4 P15 ECAT-ID4
5 GND GND
6 +3.3V VCC

Figure 2-5 EtherCAT Explicit Device ID Connection

EtherCAT Conformance Test tool [Test Case: TF-1201 ESM - Explicit Device ldentification] expect this ID set
[5]

R30AN0400EJ0105 Rev.1.05 Page 12 of 72
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3. Sample software configuration

3.1

Folder structure

The folder structure of this sample software is shown below.

RL78_uCCM_V**
F—appl

—01_pnio

—02_eip

—03_ecat
—04_pnio_largesize
—05_eip_largesize
—06_ecat_largesize
—07_modbus_tcp_slave

—10_multi_protocol

—plat
—projects

—ugoal
—rpc
—sapi

—ext

User application

PROFINET sample application

EtherNet/IP sample application

EtherCAT sample application

PROFINET Large data size sample application
EtherNet/IP Large data size sample application
EtherCAT Large data size sample application
Modbus TCP sample application

multi-protocol [01_pnio, 02_eip, 03_ecat, 07_modbus] sample application

HW-dependent components (OS-dependent part, board spec, drivers)

Project files corresponding to each user application

Main part of uGOAL (Generic Open Abstraction Layer *)
Functional parts related to RPC (Remote Procedure Call) including NW protocols and MCTC
Simple API

external software component

* For more information about uGOAL, see “R-IN32M3 Module (RY9012A0) User's Manual Software (R17US0002ED****)".

R30ANO400EJ0105 Rev.1.05
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RL78/G14 Sample Application (UGOAL Edition)

3.2 Overview of the project
The protocols (PROFINET, EtherNet/IP and EtherCAT) in this sample software support the following

features:

Table 3-1 Protocol and feature

Protocol Feature

PROFINET

- Conformance : CC-B (RT)
* Netload : |

Min Interval : 1ms

- 1&M : 1-4

EtherNet/IP

+ DLR : Support

EtherCAT

+ DC : Support
+ Mailbox : CoE / FoE / EoE
* Profile : MDP

The sample software implements two types of data transmission/reception applications as example

applications.

» Remote-l0 (LED/Switch): LED lighting control and Switch status from the evaluation board

»  Mirror: Sends data received from the master and mirrored back

Project Protocol More detail
01_pnio PROFINET 3.4.1 PROFINET
02_eip EtherNet/IP 3.4.2 EtherNet/IP
03_ecat EtherCAT 3.4.3 EtherCAT
04 _pnio_largesize PROFINET 3.4.1 PROFINET
05_eip_largesize EtherNet/IP 3.4.2 EtherNet/IP
06_ecat_largesize EtherCAT 3.4.3 EtherCAT
07_mbus_tcp_sever | ModbusTCP 3.4.4 Modbus TCP
10_multi_protocol PROFINET / 3.4.5 multi-protocol

EtherNet/IP /

EtherCAT /

ModbusTCP

04_pnio_largesize, 05_eip_largesize, 06_ecat_largesize project has a sample project for large data
transfer using RPC communication.

See “User's Implementation Guide (UGOAL Edition) [R30AN0402EJ****]” for details on RPC

communication.

R30ANO400EJ0105 Rev.1.05
May.31.2024
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3.3 Set up of development environment
Please refer to Chapter 1.2 for the operating environment of this sample software.

3.3.1 Install
(1) IDE e2studio and GCC for Renesas RL78

Download e2studio in the following web site and install it on your PC. GCC for Renesas RL78, the GNU
Toolchain for the RL family, will be installed along with e2studio.

There are four points to note regarding the installation.

1. Do not forget to check for "RL78" in [Device Family] screen during the installation. (Multiple selections can
be made together with others)

O \ RA
. RA Build, Del

W 2

O
RZ Build, Del

W RL7E
RU78 Build, Dx

O W R
R>< Build, Del

o o e
RH850 Debug su

A

Figure 3-1 Select device family

2. Select “GCC Toolchains & Utilities” tag in [Additional Software] screen during the installation. After that,
check "GCC for Renesas RL78 4.9.2.202201" and install GCC.

Renesas QE (0) Renesas Toolchains & Utilities (0) FCC Toolchains & Utilities {41

=& GCC _LLVM for Renesas RL78 (Registration Required
GCC for Renesas RL78 4.9.2.202201 4.9.2.202201

GCC for Renesas RL78 4.9.2.202201

Figure 3-2 Select additional software

R30AN0400EJ0105 Rev.1.05 Page 15 of 72
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3. During the installation of the GCC compiler, a CyberTHOR Studios Limited user registration may be
required.

If you do not have an account, please register from "Register Now". Alternatively, you can also register from
the Open Source Tools for Renesas (llvm-gcc-renesas.com).

[JP] Registration Information OfEffams

UP1 CyberTHOR Studios GNU Tools are free to download and use with worldwide technica
support provided free of charge. We do ask however that if you would like to use the tools,
you kindly register at https:igec-renesas.com. In order to allow nrestrictsd distribution of
these tools, this installer requires that you enter a unique code to show that you have already
registered. If you are already a registered user, you can find this activation code on our
website (hitps:/fgce-renesas.com). Simply log in to your account and click the Dashboard
button in the upper left comer of the screen to view your activation code. Once you have
your activation key, please check the "l am a registered user” box above and press the Hext”
button to proceed

If you are not a registered user, you can register online at hitps/igcc-renesas.com or by
pressing the "Register Now" button below.

Registration is free, quick and easy and is only required once. Your detais are securely
stored by s and will never be sold or given away. Ve Use your detais to justify the
development wark we do on the tools and to very occasionally send you e-mails about our
releases (you can apt out f these e-mails if you prefer).

Thank you for helping us make these tools freely distributable.

Felf)l I Register Now I <E3E) Next >

Figure 3-3 Install GCC compiler (no account)

After registering or if you have an account, check “registered use” and select [Next>]. In the next pop-up,
enter the registered e-mail and Authentication Code to proceed with the GCC installation.

4. Make sure that [Change PATH environment variable automatically] is checked and proceed with the
installation.

[JP] Registration Information I FATI] T am 2 registered ussjl

P] CyberTHOR Studios GNU Tools are free to download and use with wordwide technical
support provided free of charge. We do ask however that if you would like to use the tools,
vou kindly register at https:/gec-renesas.com. In erder to allow unrestricted distribution of
these tools, this installer requires that you enter a unique code to show that you have already.
registered. If you are already a registered user, you can find this activation code on our
website (hitps:/fgcc-Tenesas.com). Simply log in to your account and click the Dashboard
button in the uppar Ieft comer of the screen to view your activation code. Once you have
your activation key, please check the ™l am a registered user” box above and press the “Next”
button to proceed

If you are not a registered user, you can register online at https igcc-renesas.com or by
pressing the "Register Now” button below.

Registration is free, quick and easy and is only required once. Your detais are securely
stored by us and will never be sold r given away. We use your detais to justify the
development wark we do on the tools and to very occasionally send you e-mails about our
releases (you can apt out of these e-mails if you prefer).

Thank you for helping us make these tools freely distributable.

Foutl Retrieve Code <E3@) I Next > I

Figure 3-4 Installation of GCC compiler (account possession)

R30AN0400EJ0105 Rev.1.05 Page 16 of 72
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3.3.2 Connection
(1) No additional connection
After stacking the Adapter board with R-IN32M3 Module on RL78/G14 Fast Prototyping Board (For details,

please refer to Chapter 2.1), connect your PC as follows. Power is supplied to those boards by connecting a
USB micro B cable to RL78/G14 Fast Prototyping Board.

(LAN) Ethernet cable

Adaptor board with R-IN32M3 Module
(Connect to Arduino connector)

e2studio

§ RL78/G14

USB micro B

:P cable

Figure 3-5 Connection configuration

R30AN0400EJ0105 Rev.1.05 Page 17 of 72
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(2) Additional Pmod SWT and Pmod LED connection

Connect Pmod SWT (refer to Table 1-2) to Pmod2 terminal Upper (1-6 pin) and Pmod LED (refer to Table
1-2) to Pmod1 terminal Lower (7-12 pin) on RL78/G14 Fast Prototyping Board (For details, please refer to
Chapter 2.3). Power is supplied to those boards by connecting a USB micro B cable to RL78/G14 Fast
Prototyping Board.

Pmod SWT
(Connect to Pmod2

Upper(1-6pin))

Pmod LED
(Connect to Pmod1
Lower(7-12pin))

(LAN) Ethernet cable

Adaptor board with R-IN32M3 Module
(Connect to Arduino connector)

e2studio
R Software PLC

e? studio

R RL78/G14

USB micro B

:P cable

Figure 3-6 Connection configuration (connection with Pmod SWT and Pmod LED)

R30AN0400EJ0105 Rev.1.05 Page 18 of 72
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RL78/G14 Sample Application (UGOAL Edition)

3.3.3

Import project

(1) Unzip package

First, unzip the archived package of this sample software (RL78_uCCM_V***.zip) and store it in arbitrary
folder. Because e2studio cannot recognize project properly if file path is too long in the folder hierarchy,
place it in shorter path. Also, do not use multi-byte character, such as Japanese, in the folder path.

(2) Execute e2studio

Execute "e2studio.exe" to start e2studio in the following folder (default case) installed:

\Renesas\e2_studio\eclipse\e2studio.exe

To check the compiler installed above, select [Window] -> [Preferences], and then select [Renesas] ->
[Renesas Toolchain Management] in the Settings dialog. In the dialog [Renesas Toolchain Management], it

can be seen whether an appropriate compiler has been added to "GCC for Renesas RL78".

type filter text

Install/Updste
Java
Library Hover
LinkerScript
Mcu
Oomph
Remote Development
~ Renesas
Breakpoints
Device add-ins Suppc
FSP Configuration Ed
Launch Settings
Logging
Module Download
My Renesas
Renesas QF
Renesas Toolchain M
Smart Browser
Smart Configurator
Smart Demo
Smart Manual
Support Folders
Tracealyzer
TraceX
Run/Debug
Scripting
< >

=3
@ b

Toolchain Type
LLVM for RL7S
[] GNU ARM Embedded
Renesas CCRL
W] Renesas CCRX

Renesas Toolchain Management

Installation Path

[ KPIT GNURL78-ELF Toelchain

GCC for Renesas RX
Renesas SMS Assembler
[] KPIT GNURX-ELF Toolch

ain

v or Renesas RL7&
4,8,2.202103

[ 4.8.2.202002
4.9.2.201904

- s nn
powsl @ Be lmimow
w WS e
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h—hia i Ll L
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Apply and Close.

Cancel

Figure 3-7 Renesas Toolchain Management
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R-IN32M3 Module (RY9012A0) RL78/G14 Sample Application (UGOAL Edition)

(3) Import project
Import the sample project into e2studio from the following steps:

[File] -> [Import...] on the right of the screen.

Edit Source Refactor Mavigate Search Project RenesasViews Run
New Alt+Shift+N > 1 Configurations

Open File... 1

. Open Projects from File System... I

Recent Files >

Close Editor

Close All Editors

ve Ctrl+S

[
[

&

re As...
Save All Ctrl+Shift+5

Revert
Move...
Rename... F2

Refresh F5

Convert Line Delimiters To ¥

sy

Print... Ctrl+P

E Import...

£y Export..

Pronerties Alt+Fnter

Figure 3-8 Import

In the [Select] dialog, select [General] -> [Existing Project into Workspace], and then select [Next>].

e |mport
Select \
Create new projects from an archive file or directory. E o 5 |

Select an import wizard:

type filter text |

v [= General -
JE Archive File

SIS Pack
1= Existing Projects into Workspace I
J File System

[C] Preferences
(=} Projects from Folder or Archive

= Rename & Import Existing C/C++ Project into Workspace
e Renesas C5+ Project for CATSKOR/CATEKD
e Renesas C5+ Project for CC-RX and CC-RL

= C/C++

Figure 3-9 Select “Existing Projects into Workspace”
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In the [Import Projects] dialog, select [Select root directory] check box, and then select [Browse].
Select the package of this sample software "RL78_uCCM_V***" stored in arbitrary folder at 3.3.3(1) and
select [OK].

[ B ropert [w] b4
Impart Projects
St g ey 0 st Y pesting B e projers ’
W Sedacy o) dlwciong | T W ROEATRAT D3 0T VI |T|
Sackecd rurees lle
Propacic

= B prea__niSgl& oulen |08 S TENFLAE o0 V1

Dybure
L Saared tor remted pezjacic

Figure 3-10 Import Projects

After putting a check in the sample project to be used from each sample project listed in [Projects],
select [Finish] to import the project.

File Edit Source Refactor Navigate Search Project
- L ] F v Cﬁ -

& Project Explorer | =&Y §=0
‘;:3 01_pnio_rl78g14_osless (in rl7

‘_"_—C,' 02_eip_rl78g14_osless (in 1

1% 03_ecat_rl78g14 _osless (in rl78g14)
‘_r_—“;v 04_pnio_largesize_rl78g14_osless |
‘_r_—"} 05_eip_largesize_rl78g14_osless (in«
‘_w;"v 06_ecat_largesize_rl78g14_osless (in
1_‘-_—‘;, 07_mbus_tcp_server_rl78g14_osless |

‘_‘-_—5- 10_multi_protocol_rl78g14 osless (in rl78g14

Figure 3-11 Imported projects
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3.3.4 Build project
In the [Project Explorer] on e2studio, select the sample project, select the arrow next to the [Build] button
(hammer icon), and select [HardwareDebug] from the drop-down menu.

File Edit Source Refactor Navigate Search Project RenesasVie

| ®~R~ e Q-

{5 Projecte ¥ 1 HardwareDebug h 3 = g
™ Tlé 01_pnio_rl78g14_osless (in rl78g14) [HardwareDebug
! Includes
(A uGOAL

=| 01_pnio__rl78g14 _osless HardwareDebug.launch
4)
14)

1% 04_pnio_largesize_ri78g14_osless (in rl78g714)

"_.-_—5' 02 _eip_ri78g14 osless (in rl78c
"_.-_—E- 03_ecat_rl78g14_osless (inrl78g

Figure 3-12 Build project

e2studio builds the selected project. When the build is complete, "Build Finished" message can be seen in
the [Console] at the bottom of the screen.

|#] Problems | B) Console 2 |@ Smart Browser [} Smart Manual
[COT Build Consele [mirror_sample__01_pnio__rl78g14_osless]

B6:35:54 Build Finished. @ errors, @ warnings. (toock 56s5.894ms)

Figure 3-13 Build finished
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3.3.5 Debug
Once the build is complete, it is possible to start debugging immediately. Select the arrow next to the [Debug]
button (bug icon) and select [Debug Configurations...].

|

(no launch history)

= 7 |8zg Debug As »
==
Therel Debug Configurations...

antent outlin Organize Favorites...

Figure 3-14 Debug Configurations

In the [Debug Configuration] dialog, select the appropriate "xxxx HardwareDebug" from [Renesas GDB
Hardware Debugging] and select the [Debug] button to launch the debug screen.

ebug Configurations

Create, manage, and run configurations @.

FoREX BT~ Name: [mirror_sample_01_prio_ri78g14_osless HardwareDebug |
[type fitter text ||| & Main| %5 Debuager| B> Startup| [ Commen| & Source
[] ¢/C++ Application Project
[] C/C++ Remote Application
EASE Script [ mirror_sample_01_pnio_ri78g14 osless Browse...

[£] GDB Hardware Debugging C/C++ Application:
[£] GDB OpenOCD Debugging
[E9 GDB Simulator Debugging (RH8s0)

| HardwareDebug/mirror_sample_o1_pnio_ri7q14_osless.lf

1 Java Applet Variables.. | Search Project..| | Browse..
[0 Java Application Build (if required) before launching
& Launch Group
[T, Remote Java Application Build Configurotion: | Select Automatically v
=1 GRE actiace Dot
O Enable auto build O Disable auto build

[c7] mirror_sample_01_pnio_rl78g14_osless HardwareDebug

@® Use workspace settings Configure Workspace Seffings...

(L e e - M e I e
[E7 mirror_sample_03 _ecat_rI7ég14_osless HardwareDebug
mirror_sample_04_pnio_largesize_rI78g14_osless HardwareDebu
mirror_sample_05_eip_largesize_r|78g14_osless HardwareDebug
[E7] mirror_sample_06_ecat_largesize_rl78g14_osless HardwareDebu

[E Renesas Simulator Debugging (RX, RL78)

< >
Filter matched 18 of 20 items

@ I Debug I Close

Reyert Apply

Figure 3-15 Debug start

If a firewall warning for "e2-server-gdb.exe" is shown, check all check boxes, "Domain", "Private" and
"Public", and select [Allow access].

If asked to change the perspective in the Confirm Perspective Switch dialog, check the check box of [Always
use this setting] and select [Yes].

When the debugger screen is up and the program download is complete, select the [Restart] button to run
the program.
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3.4 Protocol communication and Application control

This section describes the protocol communication using Management Tool (PROFINET, EtherNet / IP
connection) or TwinCAT (EtherCAT connection), and how to control each sample application.

3.41 PROFINET

This chapter describes an example of PROFINET communication.
The target sample is below.

Table 3-2 PROFINET Sample software

Sample software Overview

01_pnio Cyclic connection sample

04_pnio_largesize | Cyclic and RPC (Large Size data) connection sample

10_multi_protocol | 01_pnio, 02_eip, 03_ecat, 07_modbus multi sample

To use this sample application, you need to update the firmware version of the R-IN32M3 Module to 2.1.0.0
or later. For the firmware update method, see "R-IN32M3 Module (RY9012A0) Management Tool Instruction
Guide (R30ANO390EJ****)".

1. Evaluation Environment Setup

-1. Evaluation Board Preparation

Refer to Chapter 3.3. to prepare the development environment.
Build the project and run the sample application, referring to Chapters 3.3.4 to 3.3.5. When the
sample application is run, the protocol display LED (PROFINET) turn on.

Figure 3-16 Protocol LED: PROFINET
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-2. Set IP address

Set Static IP address. Open the [Network Properties] of the network adapter connected to the R-

IN32M3 Module and set the static IP (using 192.168.0.1 as an example).

Table 3-3 IP Address

IP address 192.168.0.1

Netmask 255.255.255.0

AyF=Fy+ ORI -3 4 (TCRAPvA)DTO/T1

=2
FIRD-DTIDREHHR-FEN TV A AN, IP BEEEBMICBTAEAT
5T HR-FENTVEMESTL Ry b-PEBEENE P SEEBVEDET
G,

O P PELAE S BEIICEES 3(0)

@ RO IP FRLAEEI(SK

T S
@® 20 DNS $—/(~0PFLAREI(E:
O#THEEERET (L) =EEEN.
vl

Figure 3-17 Set Static IP address
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2. Master connection

Management tool can be used as a PROFINET simple master. It is included with " R-IN32M3 Module
(RY9012A0) Sample Package" (R18ANO064EJ****) along with this sample software.

Execute "ice.exe" file in the folder below to start the Management tool. For more information about the
Management tool, see "R-IN32M3 Module (RY9012A0) Management Tool Instruction Guide
(R30ANO390EJ****)".

-1.  Select network to use in [Network Navigator] panel and select [Scan Network] button.

“"" Industrial Communication Explorer
File

(& PNIO Master | [7] D

Device Commands

Scan device

= Snapshots Device Data

Station name:

Figure 3-18 Scan network

-2. “Scan complete. found 1 device” message is displayed in [Network Scan] dialog, then select [OK].

Scan network =ralrk IRE bk Faw loste e “

Running scan using local IP 192.168.0.1

Scan complete. Found 1 device.

Figure 3-19 Scan completed
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-3. In [Network Navigator] panel in the scanned network, “R-IN32M3_Module” is displayed as the new
device, so select [R-IN32M3_Module].

rt:. Network Navigator] \ r@ PNIO Mast
v = Network Interfaces Device Co
v B F e BT Do (1) Scand

| = _R-IN32M3_Module (0.0.00) ]
- B LR w2 e e B 5 °(0) Device Da
= Snapshots Station na
Device Ty
Device Ro
IP Addres:
Netmask:

Figure 3-20 Select R-IN32M3 Module

-4. In order to communicate with the R-IN32M3 Module, the IP address of the R-IN32M3 Module must be
in the same IP network as the IP address of the PC. Therefore, access the configuration manager
variables (volatile memory and non-volatile memory stored configuration variables) of the R-IN32M3
Module to set the IP address and Netmask.

With [R-IN32M3_Module] selected, select [Read Configuration] button while displaying the
[ConfigManager] panel.

[~ Industrial Communication Explorer

|@ PNIO Master 0 EtherNet/IP Master [] Device Log|

(A ConfigManager

| Module Variable Action Type |1
v & Network Interfaces
v W Do B

& R-IN32M3_Module (0.0.0.0)
el(R) Dual Band Wireless-AC &

=
= Snapshots

Figure 3-21 ConfigManager
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-5. In the configurations displayed in the [ConfigManager] panel, change the following items. Note that it
is required to set VALID to 1 due to enable the IP address and Netmask. The changed Value will be
highlighted in yellow.

Table 3-4 GOAL_ID_NET

Module Variable Value example
GOAL_ID_NET IP 192.168.0.100
GOAL_ID_NET NETMASK 255.255.255.0
GOAL_ID_NET VALID 0x01

b4 ConfigManagef] E EtherNet/IP Master (ZJ) PNIO Master [] Device Log s Firmware Update €3 Exception Log @ EtherCAT Mast
Module Variable Action Type Temp Read Write Value
GOAL_ID_ETH SPEED uint32 X X X 0x0000000b
GOAL_ID_ETH DUPLEX uint32 X X X 0x00000007
GOAL_ID_ETH PORTCNT uint32 X X X 0x00000002
IGOAI._ID_NI:T P 1Pv4 X X | 192.168.0.100
FDAL_\D_NET NETMASK IPv4 X X 255.255.255.0
GOAL_ID_NET ow 1Pva X X 0000
Jsoaioner  vaup uint® X X o1 |
GOAL_ID_NET DHCP_ENABLED uints X X ox00
GOAL_ID_NET DHCP_STATE uints % X X 0x00
GOAL_ID_NET DNS0 1Pva X X 0000
< >
1) Export Config | 4 Import Config % Save config to flash

Figure 3-22 Set IP address on R-IN32M3 module

-6. Select [Write Configuration] button to download the changed Configuration Manager variables to the
R-IN32M3 Module.

" Industrial Communication Explorer

5. Network Navigator]

v = Network Interfaces
v ® Realtek USB GbE Family Controller (1)
== R-IN32M3_Module (0.0.0.0)

% Intel(R) Ethernet Connection 1219-LM (0]

e
- '

Figure 3-23 Download Config variables
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-7. If a change confirmation dialog is displayed, select [Yes]. The changed value is then transferred to the
R-IN32M3 Module and changed in RAM only. If change the value of Flash incorporated in the R-
IN32M3 Module, use the [Save config to flash]. The changed IP address setting is applied after the
system is restarted, so restart this board.

For details on the IP address setting, refer to Chapter 4.3.

-8. Select [PNIO Master] panel, and then select [Scan device].

@ PNIO Master | [] Device Log % ConfigMana

Device Commands

Set station name Set If

Device Data

Station name:
Device Type:
Device Role:
IP Address:
Netmask:

Rakauscann

Figure 3-24 PNIO Master

-9. When a PROFINET device is detected, "PNIO: Found 1 device" appears in [Messages] panel at the
bottom of the screen, and [Device Data] in the [PNIO Master] panel displays the device information of

the R-IN32M3 Module.

[ PNIO Master | ) Etherbet/IP Master [] Device Lag 3 ConfigManager ¢
Device Commands
Scan device Set station name Set IP settings Wink
Device Data
Station name:
Device Type: Renesas Electronics
Device Role: 10-Device
IP Address: 192.168.0.100
Netmask: 255.253.255.0
Gateway: 0.00.0

Figure 3-25 Device Data
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-10. Open the I/O panel of |
file. GSDML files can b

PNIO Master] panel and select [Load GSDML file] button to import the GSDML
e found in the following folder:

Table 3-5 GSDML File

Sample software

GSDML file

01_pnio

10_multi_protocol

11_pnio_http

01_pnio\gsdmN\GSDML-V2.43-Renesas-irj45-20240130_01_pnio.xml

04_pnio_largesize

04_pnio_largesize \gsdml\ GSDML-V2.43-Renesas-irj45-20240130_04_pnio.xml

Verify that [Slots:] and [Modules] display contents as set in GSDML, select [32] from pull-down of
[Device Interval] and then push [Connect] button. If the connection is successful, this button switches

to [Disconnect] button.

In addition, the protocol status LED lights up.

(;i EtherCAT Master | () PNIO Master |U Devicelog & ConfigManager ~y Firmware Update (T EtherNet/IP Master €3 Except
/O Commands 1/Q Configuration
| &% Comnect | Load GSDML file
Language
eng (Primary) ~
Device Access Point
RIN32M3_Module ~
Slots: Modules:
Slot 1 | Switch Status A
Slot 2 | Unsigneds
Slot 3 | OctedString 16 bytes
Slot 4 | Unsignedia
| OctedString 32 bytes
| OctedString 32 bytes
| OctedString 32 bytes
| Unsigned32
| OctedString 16 bytes
| OctedString 32 bytes
O LED Request
0 Unsignedd v
Device Interval:
32 ~
Device Command} 110 I&M  User-defined Records  Alarms

Figure 3-26 GSDML
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-11. Data communication for sample applications.
The sample software implements two types of data transmission/reception applications as example
applications.

> Remote-lO (LED/Switch): LED lighting control and Switch status from the evaluation board
Target Project : 01_pnio, 04_pnio_largesize, (10_multi_protocol)

»  Mirror: Sends data received from the master and mirrored back
Target Project : 01_pnio, 04_pnio_largesize, (10_multi_protocol)

»  Mirror (RPC) : Sends data received from the master and mirrored back

Target Project : 04_pnio_largesize

Table 3-6 Application defied:

sample | Sample app. Slot Size
LED Data Reception Slot 2 1
o . .
‘g Mirror Data Reception Slot 4 16
I . .
= Switch Data Transmission Slot 1 1
g Mirror Data Transmission Slot 3 16
o
® . .
—O| Mirror Data Reception_1 (rpc) Slot 6 32
S_I Mirror Data Reception_2 (rpc) Slot 8 32
po) Mirror Data Reception_3 (rpc) Slot 10 32
,
Mirror Data Transmission_1 (rpc) Slot 5 32
Mirror Data Transmission_2 (rpc) Slot 7 32
Mirror Data Transmission_3 (rpc) Slot 9 32
Slots: Modules:
w Slot 1 ~ | Switch Status A
~ | Switch Stat | Switch Status
| Switch £ ~ | Unsigneds
w Slot 2 | Unsigneda
O LED Requ w | OctedString 16 bytes
w Slot 3 | OctedString 16 bytes
w | OctedStrin w | Unsignedi16
| OctedSt | Unsigned 16
w Slot 4 w | OctedString 32 bytes
w O OctedStrii | OctedString 32 bytes
O Octed! ~ | OctedString 32 bytes
| OctedString 32 bytes v

Device Interval:

Figure 3-27 Application define (ex. 01_pnio)
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Remote-lO (LED/Switch)

Input data corresponding to P-mod switches is registered in Switch, and Output data corresponding to
P-mod LED is registered in LED as 1-byte data.

Table 3-7 /O app.

1/0 app. Remote 1/0 control

Switch P-mod Switch Input Data value changes by operating P-mod switches
(Slot 1)

LED P-mod LED P-mod LED changes by registering a value to Output Data.
(Slot 2)

1/0 Data

Medule/Submedule

~ Switch
~ Switch

Input byte

v LED
v LED

Output byte

<

Device Commands |10

Data Type PS/CS Input Data Qutput Data

128/0
Unsigneds 0x03

0 /128
Unsigneds 0x09

&M

UadoNY)

-
daL/3hqpoy

1999813
1oz

Figure 3-28 Remote 1/O control [PROFINET]
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Mirror control

When a module receives a value registered in Output Data from the master, the value is mirrored back
to the master and reflected in Input Data.

Here is an example of mirror control for the 01_pnio sample.

Table 3-8 Mirror app.

Mirror app. Mirror control

Mirror Data Transmission | Values sent from the module under mirror control are reflected in
(Slot 3: Input 16Byte) Input Data.

Mirror Data Reception Module receives values registered in Output Data

(Slot 4: Output 16Byte)

1/O Data
Medule/Submedule Data Type Input PS/CS Output PS/CS Input Data Output Data

| Switch Status

O LED Request
+ | OctedString 16 bytes

v | OctedString 16 bytes 128/128 .
Input 16 bytes OctetString D EE FF Reception:
v O OctedString 16 bytes Master to Slave
+ O OctedString 16 bytes 128/128
Output 16 bytes OctetString 00 112233445566 778399 AA BB CCDDEEFF

Figure 3-29 Mirror control [PROFINET]

-12. [Disconnect] terminates communication.
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3.4.2 EtherNet/IP

This chapter describes an example of EtherNet/IP communication.
The target sample is below.

Table 3-9 EtherNet/IP Sample software

Sample software Overview

02_eip Cyclic connection sample

05_eip_largesize Cyclic and RPC (Large Size data) connection sample

10_multi_protocol | 01_pnio, 02_eip, 03_ecat, 07_modbus multi sample

To use this sample application, you need to update the firmware version of the R-IN32M3 Module to 2.1.0.0
or later. For the firmware update method, see "R-IN32M3 Module (RY9012A0) Management Tool Instruction
Guide (R30ANO390EJ****)".

1. Evaluation Environment Setup

-1. Evaluation Board Preparation

Refer to Chapter 3.3. to prepare the development environment.
Build the project and run the sample application, referring to Chapters 3.3.4 to 3.3.5. When the
sample application is run, the protocol display LED (EtherNet/IP) turn on.

Figure 3-30 Protocol LED: EtherNet/IP
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-2. Set IP address

Set Static IP address. Open the [Network Properties] of the network adapter connected to the R-

IN32M3 Module and set the static IP (using 192.168.0.1 as an example).

Table 3-10 IP Address

IP address 192.168.0.1

Netmask 255.255.255.0

AyF=Fy+ ORI -3 4 (TCRAPvA)DTO/T1

=2
FIRD-DTIDREHHR-FEN TV A AN, IP BEEEBMICBTAEAT
5T HR-FENTVEMESTL Ry b-PEBEENE P SEEBVEDET
G,

O P PELAE S BEIICEES 3(0)

@ RO IP FRLAEEI(SK

T S
@® 20 DNS $—/(~0PFLAREI(E:
O#THEEERET (L) =EEEN.
vl

Figure 3-31 Set Static IP address

R30ANO400EJ0105 Rev.1.05
May.31.2024

RENESAS

Page 35 of 72




R-IN32M3 Module (RY9012A0)

RL78/G14 Sample Application (UGOAL Edition)

2. Master connection

Management tool can be used as a EtherNet/IP simple Scanner. It is included with " R-IN32M3
Module (RY9012A0) Sample Package" (R18ANO064EJ****) along with this sample software.

Execute "ice.exe" file in the folder below to start the Management tool. For more information about
the Management tool, see "R-IN32M3 Module (RY9012A0) Management Tool Instruction Guide

(R30ANO390EJ****)".

-1. Select network to use in [Network Navigator] panel and select [Scan Network] button.

? Industrial Communication Explorer

File

= Snapshots

(& PNIO Master | [7] D

Device Commands

Scan device

Device Data

Station name:

Figure 3-32 Scan network

-2. “Scan complete. found 1 device” message is displayed in [Network Scan] dialog, then select [OK].

Scan network *ralrk IBE bk Fam g Lesto e

Running scan using local IP 192.168.0.1

Scan complete. Found 1 device.

n

Figure 3-33 Scan completed
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-3. In [Network Navigator] panel in the scanned network, “R-IN32M3_Module” is displayed as the new
device, so select [R-IN32M3_Module].

rt:. Network Navigator] \ r@ PNIO Mast
v = Network Interfaces Device Co
v B F e BT Do (1) Scand

| = _R-IN32M3_Module (0.0.00) ]
- B LR w2 e e B 5 °(0) Device Da
= Snapshots Station na
Device Ty
Device Ro
IP Addres:
Netmask:

Figure 3-34 Select R-IN32M3 Module

-4. In order to communicate with the R-IN32M3 Module, the IP address of the R-IN32M3 Module must be
in the same IP network as the IP address of the PC. Therefore, access the configuration manager
variables (volatile memory and non-volatile memory stored configuration variables) of the R-IN32M3
Module to set the IP address and Netmask.

With [R-IN32M3_Module] selected, select [Read Configuration] button while displaying the
[ConfigManager] panel.

[~ Industrial Communication Explorer

|@ PNIO Master 0 EtherNet/IP Master [] Device Log|

(A ConfigManager

| Module Variable Action Type |1
v & Network Interfaces
v W Do B

& R-IN32M3_Module (0.0.0.0)
el(R) Dual Band Wireless-AC &

=
= Snapshots

Figure 3-35 ConfigManager
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-5. In the configurations displayed in the [ConfigManager] panel, change the following items. Note that it
is required to set VALID to 1 due to enable the IP address and Netmask. The changed Value will be
highlighted in yellow.

Table 3-11 GOAL_ID_NET

Module Variable Value example
GOAL_ID_NET IP 192.168.0.100
GOAL_ID_NET NETMASK 255.255.255.0
GOAL_ID_NET VALID 0x01

b4 ConfigManagef] E EtherNet/IP Master (ZJ) PNIO Master [] Device Log s Firmware Update €3 Exception Log @ EtherCAT Mast
Module Variable Action Type Temp Read Write Value
GOAL_ID_ETH SPEED uint32 X X X 0x0000000b
GOAL_ID_ETH DUPLEX uint32 X X X 0x00000007
GOAL_ID_ETH PORTCNT uint32 X X X 0x00000002
IGOAI._ID_NI:T P 1Pv4 X X | 192.168.0.100
FDAL_\D_NET NETMASK IPv4 X X 255.255.255.0
GOAL_ID_NET ow 1Pva X X 0000
Jsoaioner  vaup uint® X X o1 |
GOAL_ID_NET DHCP_ENABLED uints X X ox00
GOAL_ID_NET DHCP_STATE uints % X X 0x00
GOAL_ID_NET DNS0 1Pva X X 0000
< >
1) Export Config | 4 Import Config % Save config to flash

Figure 3-36 Set IP address on R-IN32M3 module

-6. Select [Write Configuration] button to download the changed Configuration Manager variables to the
R-IN32M3 Module.

" Industrial Communication Explorer

5. Network Navigator]

v = Network Interfaces
v ® Realtek USB GbE Family Controller (1)
== R-IN32M3_Module (0.0.0.0)

% Intel(R) Ethernet Connection 1219-LM (0]

e
- '

Figure 3-37 Download Config variables

R30AN0400EJ0105 Rev.1.05 Page 38 of 72
May.31.2024 RENESAS
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-7. If a change confirmation dialog is displayed, select [Yes]. The changed value is then transferred to the
R-IN32M3 Module and changed in RAM only. If change the value of Flash incorporated in the R-
IN32M3 Module, use the [Save config to flash]. The changed IP address setting is applied after the
system is restarted, so restart this board.

For details on the IP address setting, refer to Chapter 4.3.

-8. Open [EtherNet/IP Master] panel and select [Scan device] button.

TG EtherNet/IP Master lp PNIO Master [] Device Log % Conf

Device Commands

Device Data

Encapsulation protocol version:
Adress Familiy:

Port:

IP Address:

Vendor ID:

Device Type:

Figure 3-38 Scan device

-9.  When an EtherNet/IP device is detected, [Messages panel] at the bottom of the screen displays "EIP:
Found 1 device" and [Device Data] in [EtherNet/IP Master] panel displays the device information for
the R-IN32M3 Module.

1T EtherNet/1P Mast«] () PNIO Master & ConfigManager [] Dev

Device Commands

Device Data
Encapsulation protocol version: 1
Adress Familiy: AF_INET
Port: 44818
IP Address: 192.168.0.100
Vendor ID: 1105
Device Type: Generic Device
Product Code: 768
Revision: 1.1
R Owned
+ Configured

X Minor Recoverable

uuuuuu

Device Commands /O Data

5 Messages]

2020/10/13 23:15:45  JRE version: 11
=] 2020/10/1323:19:58 Scanned Realtek USB GbE Family Controller
Found 1 device.
Read 113 variables from 2E:09:0A:03:DE:F6

. Scanned Realte B GbE Family Contre
EIP: Found 1 device.

J 2020/10/13 23:23:48|

Figure 3-39 Device Data
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RL78/G14 Sample Application (UGOAL Edition)

-10. Open [I/O Data] panel in [EtherNet/IP Master] panel.
The sample software implements two types of data transmission/reception applications as example

applications.

> Remote-lO (LED/Switch): LED lighting control and Switch status from the evaluation board

Target Project : 02_eip, 05_eip_largesize, (10_multi_protocol)
»  Mirror: Sends data received from the master and mirrored back
Target Project : 02_eip, 05_eip_largesize, (10_multi_protocol)

»  Mirror (RPC) : Sends data received from the master and mirrored back

Target Project : 05_eip_largesize

Application defied:
Table 3-12 Data application

sample | Sample app. Assembly ID | size
LED Data Reception 150 1
S | Mirror Data Reception 151 16
SI Switch Data Transmission 100 1
q§> Mirror Data Transmission 101 16
E_' Mirror Data Reception_1 (rpc) 152 32
'LEI Mirror Data Reception_2 (rpc) 153 32
© Mirror Data Reception_3 (rpc) 154 32
I Mirror Data Transmission_1 (rpc) 102 32
Mirror Data Transmission_2 (rpc) 103 32
Mirror Data Transmission_3 (rpc) 104 32

Table 3-13 Configuration

sample | Sample app.

Assembly ID | size

_elp

Config Data

02_ei

05_eip_large

200 10

R30ANO400EJ0105 Rev.1.05
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Remote-IO (LED/Switch)

Refer to Table 3-12 and Table 3-13 to set the connection parameters.

Packet interval in ms is left at the default value.

Device Commands

Connection Parameter O0->T Connection Parameter T->0

Assembly Instance ID Assembly Instance ID

[E—
Assembly Data Size Assembly Data Size

Run/ldleHeader ] Run/IdleHeader

Packet interval in ms 0 Packet interval in ms 0

Connection type Point to Point  ~ ‘Connection type Multicast ~
Priority Urgent ~ Priority Urgent ~
Transport trigger Cyclic ~

Timeout multiplier 2w

—bondiadosernbl Pararnziers
Config Assembly size
Config Assembly size

Ul o0 o0 oo on oo 00 oo
o0 oo
Config Assembly Data

Figure 3-40 Remote-lO application parameter
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Mirror control

Refer to Table 3-12 and Table 3-13 to set the connection parameters.

Here is an example of mirror control for the 02_eip sample. Packet interval in ms is left at the default

value.
Device Commands
~Connection Parameter 0->1
Assembly Instance ID 151 Assembly Instance ID 101
Assembly Data Size Assembly Data Size 16
Run/IdleHeader [JRun/IdleHeader

Packet interval in ms Packet interval in ms
Connection type Point to Point  ~ Connection type Multicast ~
Priority Urgent ~ Priority Urgent ~
Transport trigger Cyclic ~
Timeout multiplier 2 ~
Config Assembly Parameters
Config Assembly size | 200
Config Assembly size

0o oo 0o o0 0o o0 o0 oo

0o oo
Config Assembly Data

Figure 3-41 Mirror application parameter
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Mirror control (RPC)

05_eip_largesize project also provides process data communication using RPC, which is a method
of process data communication via RPC data frames in SPI frame (128 bytes) between R-IN32M3
Module and the host MCU. Since RPC frames, which are originally intended for asynchronous data
communication, are used, it is possible to send larger data than the method using ordinary Cyclic
data frames (more than 69 bytes of process data can be transferred), but the update cycle of the
application is restricted. See “R-IN32M3 Module User’s Implementation Guide (R30AN0402EJ****)
for details.

Refer to Table 3-12 and Table 3-13 to set the connection parameters. Figure 3-42 shows an
example of a communication configuration for Mirror Data Reception_2 (153) and Mirror Data
Transmission_2 (103).

The configurable Packet interval in ms setting (so-called RPI setting) affects the data size and the
number of connections. Please evaluate carefully before deciding on the configuration values using

Device Commands
Connect
Connection Parameter O->T Connection Parameter T->0
Assembly Instance ID | 153 Assembly Instance ID 103
Assembly Data Size 32 Assembly Data Size 32
[w] Run/IdleHeader [_] Run/idleHeader
I Packet interval in ms 50 I Packet interval in ms |sn|
Connection type Point to Point  ~ Connection type Multicast ~
Priority Urgent v Priority Urgent ~
Transport trigger Cyclic o
Timeout multiplier 2 ~
Config Assembly Parameters
Config Assembly size | 200
Config Assembly size |10
00 0D OO OO 0O OO OO OO
00 00
Config Assembly Data

Figure 3-42 Mirror application (RPC) parameter

-11. Select the [Connect] button, which switches to the [Disconnect] button if the connection is successfully
established. Also, the protocol status LED on this board will light up.
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-12. Check the input/output of the application.

Remote-lO (LED/Switch)

Input data corresponding to general-purpose input switches on the SEMB1320 is registered in Switch,
and Output data corresponding to general-purpose output LEDs on the SEMB1320 is registered in
LED as 1-byte data.

/O Data O->T /O Data T->0
0s oc

[JEnable Rurt

Figure 3-43 Remote-lO (LED/Switch) control [EtherNet/IP]

Mirror control

When a module receives a value registered in I/O Data O->T from the master, the value is mirrored
back to the master and reflected in I/O Data T->O.
Here is an example of mirror control for the 02_eip sample.

PO Dala 05T WU Laka -y

00 11 22 33 44 55 66 77 — 88 99 A4h BB CC DD EE FF 00 11 22 33 44 55 66 ¥7 — 88 99 4A BE CC DD EE FF

Reception:

[ Enable Ry Scanner to Adapter

Apply

Figure 3-44 Mirror control [EtherNet/IP]

-13. [Disconnect] terminates communication.
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3.4.3 EtherCAT
This chapter describes an example of EtherCAT communication.
The target sample is below.

Table 3-14 EtherCAT Sample Software

Sample software Overview

03_ecat Cyclic connection sample

06_ecat_largesize |Cyclic and RPC (Large Size data) connection sample

10_multi_protocol | 01_pnio, 02_eip, 03_ecat, 07_modbus multi sample

To use this sample application, you need to update the firmware version of the R-IN32M3 Module to 2.1.0.0
or later. For the firmware update method, see "R-IN32M3 Module (RY9012A0) Management Tool Instruction

Guide (R30ANO390EJ****)".

1. Evaluation Environment Setup

-1. Evaluation Board Preparation

Refer to Chapter 3.3. to prepare the development environment.
Build the project and run the sample application, referring to Chapters 3.3.4 to 3.3.5. When the
sample application is run, the protocol display LED (EtherCAT) turn on.

o
8
&
&
o &
-
5
3
$
8
B S
5

Figure 3-45 Protocol LED: EtherCAT
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-2. Set Network Adapter

In order to send and receive EtherCAT frames using TwinCAT 3, the driver must be activated, see
"Software PLC Connection Guide TwinCAT (R30ANO380ED****)" for TwinCAT driver installation.

Drivers:

« TwinCAT RT-Ethernet Filter Driver
« TwinCAT Ethernet Protocol for All Network Adapters

¥ 4—H3yh 8 Properties X

Networking  Authentication Sharing

Connect using:
@ ASIX AX88178 USB2D to Gigabit Ethernet Adapter

L4 E:‘TmeAT RT-Ethernet Filter Driver A
5 Link-Layer Topology Discovery Responder
: PROFINET 10 RT-Protocol V2 3

[] g Link-Layer Topology Discovery Mapper 1/0 Driver

[CAR Twin CAT Ethernet Protacal for All Network Adspters

v
< >

This connection uses the following items:

Install. Uninstall
Description
A driver to support resl time 1/0 on NDIS devices

OK Cancel

Figure 3-46 Network Adapter: EtherCAT

Note: Depending on the network driver type, the TwinCAT RT-Ethernet Filter Driver may not be installed.
In this case, only the TwinCAT Ethernet Protocol for All Network Adapters enabled.

-3. ESlfile

Before starting TwinCAT 3, an ESI (EtherCAT Slave Information) file must be stored in the TwinCAT
folder.

The ESI file is stored in the esi folder of the sample program.
Table 3-15 ESI Files

Sample software ESiI file

03_ecat 03_ecat\esi\Renesas_RINmodule_03ecat.xml
10_multi_protocol
13_ecat_http

06_ecat_largesize |06_ecat_largesize \esi\Renesas_RINmodule_06ecat.xml

[Folder for ESI storage]
C:\TwinCAT\3.1\Config\lo\EtherCAT

R30ANO400EJ0105 Rev.1.05
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2. Master connection

TwinCAT from Beckhoff Automation is used as the EtherCAT master. See "Software PLC
Connection Guide TwinCAT (R30ANO380ED****)" for TwinCAT connection.

Operate TwinCAT according to the following procedure to check the connection with this sample
application and data transmission/reception.

-1. Windows start menu, select [Beckhoff] -> [TwinCAT 3] -> [TwinCAT XAE Shell].

-2. Select [File] -> [New] -> [Project] and create a new project of type [TwinCAT XAE Project].

-3. Select [File] -> [New] -> [Project] and create a new project of type [TwinCAT XAE Project].

@ -5 F -
Jution Explorer (Ctrl+ N B

R Solution "TwinCAT Project18' (1 project)
4 gl TwinCAT Project18
b (@l sYsTEm

X0Q|00]  Jaio|dx3 JAAISS

- g O Add New item... Ins
@ Mappings =
a Shift+Alt+A

Add Existing Item...

I \ Scan I

Solution Explorer _

Figure 3-47 Scan network

-4. Click [OK] on [HINT: Not all types of devices can be found automatically] dialog.
Click [OK] on [Init12\IO:Set State...]

-5.  When an EtherCAT module is detected, the connected network adapter is displayed with a check
mark ().

-6. Click [Yes] in [Scan for Boxes] dialog
Click [Yes] in [Active Free Run] dialog
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-7. The connection is complete when [Device x] — [Box 1] is added under [I/O] — [Devices].

Seluticn Explorer ~ o x
Q8- o-a| s
Search Selution Explorer (Ctrl+:) P~

] Solution 'TwinCAT Project59' (1 project)
4 1] TwinCAT Project58
b @ SYSTEM

MOTION

PLC

(4| SAFETY

E C++

& AnALYTICS

4 o]

4 ¥ Devices
e e ey
+B |mage
+B |mage-Info
2 SyncUnits

Inputs
W Outputs
& InfoData

v v v v v

&% Mippings

Figure 3-48 TwinCAT connection

If the EEPROM is blank and [Box 1 (PFFFFFFFF RFFFFFFFF)] is displayed, or if the ESI of different
sample application is written, it is necessary to write the ESI file of corresponding sample application
to the EEPROM. In this case, please refer to "Software PLC Connection Guide TwinCAT
(R30AN0380JJ****)" to program Sll in EEPROM.
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-8. Data communication for sample applications.
The sample software implements two types of data transmission/reception applications as
example applications.

» Remote-lO (LED/Switch): LED lighting control and Switch status from the evaluation board

Target Project : 03_ecat, 06_ecat_largesize , (10_multi_protocol)
»  Mirror: Sends data received from the master and mirrored back
Target Project : 03_ecat, 06_ecat_largesize , (10_multi_protocol)

»  Mirror (RPC) : Sends data received from the master and mirrored back

Target Project : 06_ecat_largesize

Table 3-16 Application defied:

sample | Sample app. Index [sub] | Size
LED Output 0x6200 [1] 1
§ Mirror Data out 1-16 0x6201 [1] 16
8' Switch Data Transmission 0x6000 [1] 1
g Mirror Data in 1-16 0x6001 [1] 16
f. Mirror Data out (rpc) 1-31 0x6210 [1] 31
§I Mirror Data out (rpc) 32-62 0x6210 [2] 31
8 Mirror Data out (rpc) 63-93 0x6210[3] | 31
" [ Mirror Data in (rpc) 1-31 0x6010 [1] 31
Mirror Data in (rpc) 32-62 0x6010 [2] 31
Mirror Data in (rpc) 63-93 0x6010 [3] 31

[5e C++

& AnALYTICS
i Vo

4 L Devices

4 3 Device 4 (EtherCAT)

+a Image

+B |mage-Info

2 SyncUnits
Inputs

B Cutputs

[ InfoData

Vv v v

4 T=PDO 1
# SW
4 TxPDO 2
b # din_dm_1
4 [y RxPDO
- LED
4 [l Rx<PDO 2
b M dout_dm_1
[ ‘WiState

[ d e DO TInenecas moooer ]

g .

b @ InfoData

Figure 3-49 Application define (ex. 03_ecat)
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RL78/G14 Sample Application (UGOAL Edition)

Remote-lO (LED/Switch)

Input data corresponding to general-purpose input switches on the SEMB1320 is registered in Switch,
and Output data corresponding to general-purpose output LEDs on the SEMB1320 is registered in

LED as 1-byte data.

 Cra— T

Pre-Op Sale-Op M ChangeLink..

] Clear Error
DL Sta <

Pon A: Carrier / Open Dispiay Mode.

o lesetNewhem.
Port B: No Carrer / Oosed
Insert Exiting ftem..

3 Online Wiite

Name Online
# sw s
# Westate o e
# Inputloggle 1 | Set Value Dialog X
# Sute s
ey B Add pec 2 ]
Hex [ood Cancel
Book a 1 HesEdk. |
Name Online ¢ = et ® ! Linked te
Binay 3
# sw 3 S| |
Bt Size: O1 @8 OK OO O?
FWEStSE u
# InputToggle o o1 15241 Input 0
¥ State 8 UINT 20 15480  Input 0
1'% _AdsAddr 101 AMSADDR &0 15500 Input 0
B LED 12 USINT 1.0 380 Output 0

Figure 3-50 Remote 1/O control [EtherCAT]

Mirror control

When a module receives a value registered in Output Data from the master, the value is mirrored back
to the master and reflected in Input Data.

Here is an example of mirror control for the 03_ecat sample.

M Change Link.
[ Disabled .
¥ wm nnuvoe Insert New Item...
4 Box1(Renesas Module) Insert Existing fem...
4 TPDO 1 C
# sw Move Addr
4 TPDO2 43 Online Write...
b # din_dm_1 :"::’r ?"""E Ly:l e ontee i i | e
4 [ RPDO1 AdsAddr 192.168.11.53.5.1:1001 it %
E LD # din_dm_1 00112233445566778899.L AR| # netd 192168115351 ]
B o, don 3ich it gyl *ren o3 oec
4 W RPDOZ =m0 - T
b W dout_dm_1 # din_dm_1[1] ox11 0000 0000000000000000... A
b @ WcState #l din_dm_1[2) BY
fa . Mkl
i o Is«, T Tl
#1 netid e TS AM e
# port 0x03e9 Mss&o Input 0
- LED 12 USINT 10 390 Output 0
& dout_dm_1 00112233445566776899... ARRAY[0... 160  40.0 Output 0
B ot _do_100] w00, RWTE 0
- dout_dm_1(1] o1 8vie| Reception: 0
B> dout dm 1021 (1 RYTF Master to slave n

Figure 3-51 Mirror control [EtherCAT]
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3.4.4 Modbus TCP

This chapter describes an example of Modbus TCP communication.
For an example of Modbus TCP, see "R-IN32M3 Module Modbus TCP Start-Up Manual
(R30ANOQO406EJ****)".

The target sample is below.

Table 3-17 Modbus TCP sample software

Sample software Overview

07_mbus_tcp_server | Modbus TCP sample application

To use this sample application, you need to update the firmware version of the R-IN32M3 Module to 2.1.0.0
or later. For the firmware update method, see "R-IN32M3 Module (RY9012A0) Management Tool Instruction
Guide (R30ANO390EJ****)".

R30AN0400EJ0105 Rev.1.05 Page 51 of 72
May.31.2024 RENESAS



R-IN32M3 Module (RY9012A0) RL78/G14 Sample Application (UGOAL Edition)

3.4.5 multi-protocol

This chapter describes an example of multi-protocol communication (PROFINET, EtherNet/IP, EtherCAT,
Modbus TCP).
The target sample is below.

Table 3-18 Multi-protocol sample software

Sample software Overview

10_multi_protocol multi-protocol [01_pnio, 02_eip, 03_ecat, 07_modbus] sample application

To use this sample application, you need to update the firmware version of the R-IN32M3 Module to 2.1.0.0
or later. For the firmware update method, see "R-IN32M3 Module (RY9012A0) Management Tool Instruction
Guide (R30ANO390EJ****)".

1. Evaluation Environment Setup

-1. Evaluation Board Preparation
The protocol is executed according to the value of the P-mod, referring to Chapters 2.3.

Refer to Chapter 3.3. to prepare the development environment.
Build the project and run the sample application, referring to Chapters 3.3.4 to 3.3.5.

Figure 3-52 General purpose switch (SW9)

C Reset )
Check SW for
Select protocol

Selected protocol

PROFINET EtherNet/IP EtherCAT Modbus TCP

“Remote I/O via PROFINET” process || “Remote I/O via EtherNet/IP" process “ “Remote I/O via EtherCAT” process | | “Remote 1/O via Modbus TCP” process

Figure 3-53 Multi-protocol selector flow
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Table 3-19 Pmod SWT Setting

Pmod SWT Protocol
on-off-off-off PROFINET
off-on-off-off EtherNet/IP
off-off-on-off EtherCAT
off-off-off-on Modbus TCP Server
others PROFINET

PROFINET : Pmod SWT [on-off-off-off] and others

B Flallall

Figure 3-54 PROFINET

EtherNet/IP : Pmod SWT [off-on-off-off]

R o/l

Figure 3-55 EtherNet/IP

EtherCAT : Pmod SWT [off-off-on-off]

B s/l

Figure 3-56 EtherCAT

Modbus TCP Server : Pmod SWT [off-off-off-on]

B ol

Figure 3-57 Modbus TCP Server
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-2. Set Network Adapter

Refer to the network adapter configuration procedures in the respective chapters according to the
selected protocol.

Table 3-20 Network Adapter

Protocol Refer

PROFINET 3.4.1 PROFINET
EtherNet/IP 3.4.2 EtherNet/IP
EtherCAT 3.4.3 EtherCAT
ModbusTCP 3.4.4 Modbus TCP

2. Master connection

Refer to the Master connect procedures in the respective chapters according to the selected
protocol.

Table 3-21 Master Connection

Protocol Refer
PROFINET 3.4.1 PROFINET
EtherNet/IP 3.4.2 EtherNet/IP
EtherCAT 3.4.3 EtherCAT
ModbusTCP 3.4.4 Modbus TCP
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3.5 Application Implement Guide
This chapter describes the steps to implement unique processing as a user application.

This sample software is equipped with uGOAL middleware and is structured based on its design philosophy.
uGOAL provides appl_init(), appl_setup(), and appl_loop() functions for user application-specific processing,
with appl_init() and appl_setup() executed in the initial phase of ugoal, followed by periodic appl_loop() in the
subsequent loop phases.

user application uGOAL

C

appl_init() [ ittty
uGOAL initial phase

appl_setup() In/ ittty
appl_loop() ¢----------- 4 uGOAL loop phase

Figure 3-58 Overall flow of the program

The following is an overview of the unique processing of functions in the user application. These are also
defined in goal_appl.c, which is the main source code of each sample.

Table 3-22 User applications and unique processing

Use Application Unique Processing

appl_init() Perform initialization steps before the uUGOAL core part is initialized, such
as initialization of each protocol stack, initialization of board-dependent
hardware.

appl_setup() Configure profile settings for each protocol stack, such as vendor ID

settings. It also registers callback functions and receives data from the R-
IN32M3 Module through each protocol.

appl_loop() Perform normal operations, including loop control functions.
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3.5.1 PROFINET

This chapter describes the implementation of the user application part in the I/O mirror response sample
application by PROFINET. For more information about each API, see "R-IN32M3 Module (RY9012A0) User's
Manual Software (R17US0002ED****)".

(1) appl_init

This function includes application-specific initialization steps before the uGOAL core module, etc. is
initialized. To enable PROFINET in uGOAL, it is necessary to call goal_pniolnit first and register the
uGOAL's PROFINET stack with uGOAL, therefore call the initialization routine for each module, including
goal_pniolnit.

GOAL_STATUS_ T appl_init(
void
)
{
GOAL_STATUS T res; /#%{ result */

/% initialize ccm RPC interface */
res = appl ccmRpelnit () ;
if (GOAL_RES_ERR(res)) {
goal logErr( “Initialization of ccm RPC failed” );
}

res = goal snmpInit();
if (GOAL_RES_ERR(res)) {

goal logErr( “Initialization of SNMP failed” );
}

/* initialize PROFINET */
res = goal pniolnit();
if (GOAL RES ERR(res)) {
goal logErr( “Initialization of PROFINET failed” ):

}

return res;

@ Initialize each module of GOAL. goal_pniolnit must be called from appl_init.
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(2) appl_setup

This function defines static settings for protocols, such as creating instance of PROFINET.

An instance of PROFINET is created in goal_pnioNew and ready for use. Some settings, such as how much
slot memory is reserved and which vendor ID to use, must be defined between goal_pniolnit and
goal_pnioNew. These settings are set by the API group starting with goal_pnioCfg. After goal_pnioNew, all

other APIs, such as creating slots and modules can be used.

)

GOAL _STATUS T appl setup(

void

{

res = goal snmpNew (&pInstanceSnmp, APPL SNMP ID) ;

if (GOAL_RES_ERR(res)) {
goal logBrr( “failed to create SNMP instance” );
return res;

}

/% set SNMP instance id for new PNIO instance */
res = goal pnioCfgSnmpldSet (APPL SNMP ID) ;
if (GOAL_RES_ERR(res)) {
goal logBrr( “failed to set SNMP instance id” );
return res;

/% set identification of the slave (vendor name) */
res = goal pnioCfgVendorNameSet (APPL PNIO VENDOR NAME) ;
if (GOAL_RES_ERR(res)) {

goal logBrr( “failed to set vendor name” );

return res;

/* create new PROFINET instance */
res = goal pnioNew(&pPnio, APPL PNIO ID, appl pnioCb);
if (GOAL_RES_ERR(res)) {

goal logErr( “failed to create a new PROFINET instance” );

return res;

@ Create an instance of SNMP.

@ Define static settings in the protocol. In this sample, the vendor ID, device ID and else are set.

@ Create an instance of PRFINET and register the main callback (appl_pnioCb). The main callback

function describes what to do depending on the state reported by the protocol stack. For information

about the reported status, see "R-IN32M3 Module (RY9012A0) User's Manual Software

(R17US0002ED****)".
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goal logInfo( “Initializing device structure” );

/% create subslots */
res = goal pnioSubslotNew(pPnio, APPL API, APPL SLOT 1, APPL SLOT 1 SUB 1, GOAL PNIO FLG AUTO GEN);
if (GOAL_RES_ERR(res)) {
goal logBrr( “failed to add subslot” ); @
return res;

/* create submodules */
res = goal pnioSubmodNew (pPnio, APPL MOD 1, APPL MOD 1 SUB 1, GOAL PNIO MOD TYPE INPUT,
APPL SIZE 1 SUB 1 IN, 0, GOAL PNIO FLG AUTO GEN) ;
if (GOAL_RES_ERR(res)) {
goal logErr( “failed to add submodule” );
return res;

/* plug modules into slots */
res = goal pnioSubmodPlug(pPnio, APPL API, APPL SLOT 1, APPL SLOT 1 SUB 1,
APPL_MOD 1, APPL MOD 1 SUB 1);
if (GOAL RES ERR(res)) {
goal logErr( “failed to plug submodule” );
return res;

/* PROFINET configuration succesful */
goal logInfo( “PROFINET ready” );

return res;

@ Create an instance of a sub-slot.

(® Create an instance of the sub-module and associate it with the sub-slot.
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(3) appl_loop
Process the data after initialization of uGOAL.

void appl loop(

void
)
{
GOAL STATUS T res; /% result */
uint8 t iops; /% 10 producer status */

if ((GOAL TRUE == flgAppReady) && (plat getElapseTime (tsTout) >= APPL TIMEOUT TRIGGER VAL)) {
/% read data from output module */
res = goal pnioDataOutputGet (pPnio, APPL API, APPL SLOT 4, APPL SLOT 4 SUB 1, dataDm.
APPL SIZE 13 SUB 1 OUT, &iops);
if (GOAL_RES ERR(res)) {
return;
1
/* copy data to input module */
res = goal pnioDatalnputSet (pPnio, APPL API, APPL SLOT 3, APPL SLOT 3 SUB 1, dataDm,
APPL_SIZE 3 SUB 1 IN , GOAL PNIO I0XS GOOD) ;
if (GOAL_RES ERR(res)) {
return;

}

/* read data from output module */ @
res = goal pnioDataOutputGet (pPnio, APPL API, APPL SLOT 2, APPL SLOT 2 SUB 1, dataDm.
APPL SIZE 11 SUB 1 OUT, &iops);
if (GOAL_RES ERR(res)) {
return;
1
/* copy data to input module */
res = goal pnioDatalnputSet(pPnio, APPL API, APPL SLOT 1, APPL SLOT 1 SUB 1, dataDm,
APPL_SIZE 1 SUB 1 IN, GOAL PNIO I0XS_GOOD) ;
if (GOAL_RES_ERR(res)) {
return;

}

/% update base timestamp */
tsTout = goal timerTsGet();

D Storing the reception data and setting the transmission data as a mirror response at regular intervals.
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3.5.2 EtherNet/IP

This chapter describes the implementation of the user application part in the I/O mirror response sample
application by EtherNet/IP. For more information about each API, see "R-IN32M3 Module (RY9012A0)
User's Manual Software (R17US0002ED****)".

(1) appl_init

This function includes application-specific initialization steps before the uUGOAL core module, etc. is
initialized. To enable EtherNet/IP in uGOAL, it is necessary to call goal_eiplnit and register the EtherNet/IP
stack with uGOAL. Therefore, call the initialization routine for each module, including goal_eiplnit.

GOAL_STATUS_ T appl_init(
void
)
{
GOAL_STATUS T res; /#% result */

/% initialize rpc wrappers */

res = appl ccmRpelnit () ;

if (GOAL RES ERR(res)) | @®
goal logBrr(“Initialization of ccm RPC failed”);

}

/% initialize EtherNet/IP %/
res = goal eiplnit();
if (GOAL_RES_ERR(res)) {
goal logErr (“Initialization of EtherNet/IP failed”);
} _

return res;

@ Initialize each module of uUGOAL. goal_eiplnit must be called from appl_init.
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(2) appl_setup

This function defines static settings for protocols, such as creating instance of EtherNet/IP.

Instance of EtherNet/IP is created in goal_eipNew and available for use. Some settings like vendor ID are
necessary to be set between goal_eiplnit and goal_eipNew. These settings are set by the API group starting
with goal_eipCfg. After goal_eipNew, various types of data. are accessible.

GOAL_STATUS T appl setup(
void

)

{

/% for a real device the serial number should be unique per device */
res = goal eipCfgSerialNumSet (123456789) ;
if (GOAL_RES_ERR(res)) {
goal logBrr( “failed to set Serial Number” ); D
return res;

J |

res = goal eipNew(&pHdlEip, 0, main eipCallback) ;
if (GOAL_RES_ERR(res)) {
goal logErr(“failed to create eip instance %”FMT x32, res); @
return res;

}

res = main eipAppllInit (pHd1Eip) ;
if (GOAL_RES_ERR(res)) {
goal logErr( “failed to initialize assembly and attribute configuration” ); (©)
return res;

(D Defines static settings in the protocol. In this sample, the vendor ID, product code, etc. are set.

@ Create an instance of EtherNet/IP. Registering the main callback (main_eipCallback). The callback
function describes operation depending on the state reported by the protocol stack. For information
about the reported status, see “R-IN32M3 Module (RY9012A0) User's Manual Software
(R17US0002ED****)”,

@ Set the created instance of EtherNet/IP to a CIP object.
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(3) appl_loop
Process the data after initialization of uGOAL.

void appl loop(
void
)
{
GOAL STATUS T res; /* result */

if ((GOAL TRUE == flgAppReady) && (plat getElapseTime(tsTout) >= APPL TIMEOUT TRIGGER VAL)) {
/* get output data */
res = goal eipAssemblyObjectRead (pHd1Eip, GOAL APP ASM ID OUTPUT, &outputDatal[0],
GOAL APP ASM SIZE OUTPUT) ;

/* mirror output data to input data */ C)
if (GOAL_RES OK(res)) {
GOAL MEMCPY (&inputData[0], &outputDatal[0], GOAL APP ASM SIZE INPUT) ;

/* store input data */
res = goal eipAssemblyObjectWrite (pHd1Eip, GOAL APP ASM ID INPUT, &inputDatal[0],
GOAL APP ASM SIZE INPUT) ;
1

/* update base timestamp */
tsTout = goal timerTsGet();

D Storing the reception data and setting the transmission data as a mirror response at regular intervals.
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3.5.3 EtherCAT

This chapter describes the implementation of the user application part in the I/O mirror response sample
application by EtherCAT. For more information about each API, see "R-IN32M3 Module (RY9012A0) User's
Manual Software (R17US0002ED****)".

(1) appl_init

This function includes application-specific initialization steps before the uUGOAL core module, etc. is
initialized. To enable EtherCAT in uGOAL, it is necessary to call goal_ecatInit first and register the EtherCAT
stack with uGOAL. Therefore, call the initialization routine for each module, including goal_ecatlnit.

GOAL_STATUS_ T appl_init(
void
)
{
GOAL_STATUS T res; /#% result */

/% initialize ccm RPC interface */
res = appl ccmRpeInit(); ®
if (GOAL_RES_ERR(res)) {

goal logBrr(“Initialization of ccm RPC failed”);
}

/% initialize EtherCAT */
res = goal ecatlnit();
if (GOAL_RES_ERR(res)) {
goal logErr (“Initialization of EtherCAT failed”);

) —

return res;

@ Initialize each module of uGOAL. goal_ecatlnit must be called from appl_init.
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(2) appl_setup
This function defines static settings for protocols, such as creating instance of EtherCAT.

An instance of EtherCAT is created in goal_ecatNew and ready for use. Also, if necessary, configure
EtherCAT protocol before creating instance set by the API group starting with goal_ecatCfg. After creating
instance, generate the required object dictionary and set the initial values.

GOAL_STATUS T appl setup(
void

)

{

/% enable CoE emergency */
res = goal ecatCfgEmergencyOn(GOAL TRUE) ;
if (GOAL_RES_ERR(res)) {
goal logBrr( “failed to enable CoE Emergency support” ); )
return res;

#if APPL ECAT SII INIT ==1
goal logInfo( “initializing EtherCAT SSI data” );

res = appl cemCfgSsiVendorlId(
& 03 ecat slave eeprom bin[0], /% data buffer */
~ 03 ecat slave eeprom bin len, /* data buffer length */
APPL_ECAT VENDOR 1ID) ;
if (GOAL_RES_ERR(res)) {
goal logErr( “failed to configure EEPROM ssi vendor id” );

}

/% configure SII in EEPROM before creating the EtherCAT instance */
res = appl ccmEcatSsiUpdate (

& 03 ecat slave eeprom bin[0], /* data buffer */
~ 03 ecat_slave eeprom bin len, /* data buffer length */
GOAL FALSE) ; /% always overwrite ssi data */

if (GOAL_RES_ERR(res)) {
goal logErr( “failed to configure EEPROM ssi data” );

1
#endif —

D Setting EtherCAT protocol. goal_ecatNew must be performed before an instance can be created in the
application.

@ Initialization of SlI. (Disabled by default)
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res = goal ecatNew(&pHdl1Ecat, GOAL ECAT INSTANCE DEFAULT, appl ecatCallback) ;

if (GOAL RES_ERR(res)) { ®
goal logErr( “failed to create a new EtherCAT instance” );
return res;

}

res = appl ecatCreateObjects(pHdlEcat) ;

if (GOAL_RES_ERR(res)) { @
goal_logErr( “failed to initialize object dictionary” );
return res;

} —

/% set settings for ccm firmware update via FoE */
res = appl ccmFoeUpdateSettings (

“cem. efw” /% filename beginning */
0, /% 0 —> match all characters */
0, /* password */
GOAL TRUE) ; /% only update in ESM state bootstrap */
if (GOAL RES_ERR(res)) { ®

goal logErr( “failed to configure FoE firmware update of CC” );
return res;

#if GOAL CONFIG MEDIA MA EVENT == 1
/% open GPIO ma */
if (GOAL_RES_OK (res)) {
res = goal maEventOpen(GOAL ID DEFAULT, &pHdIMaEvent, GOAL TRUE, appl gpioDcEvent); (D
if (GOAL_RES OK(res)) {
goal logInfo(“event generation enabled”) :
1
1
#endif

return res;

@ Create an instance of EtherCAT and register main callback (main_ecatCallback). The callback function
describes operation depending on the state reported by the protocol stack. For information about the
reported status, see “R-IN32M3 Module (RY9012A0) User's Manual Software (R17USO002ED****)”.

@ Generates each object dictionary (OD). OD is added by goal_ecatdynOdObjAdd or else, and end OD
generation by goal_ecatdynOdFinish in the end.

® Set up firmware update via FoE.

® Initialize the module for setting the EtherCAT Explicit Device ID. An external Pmod SWT is required to
set the ID. For details, please refer to Chapter 2.3.
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(3) appl_loop
Process the data after initialization of uGOAL.

void appl loop(
void

)

{

if ((GOAL TRUE == flgAppReady) && (plat getElapseTime (tsTout) >= APPL TIMEOUT TRIGGER VAL)) {
/* map process data */
read state8 inputl = write state8 outputl;
read state8 input2 = write state8 outputZ;

read analogl6 inputl = write analogl6 outputl;
read analogl6 input2 = write analogl6 output2; (;

/* process cyclic process data */
appl obj 200d = cntDCOEvent;
appl obj 200e = cntDClEvent;

/* update base timestamp */
tsTout = goal timerTsGet();

D Storing the reception data and setting the transmission data as a mirror response at regular intervals.
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4. Appendix
41 uGOAL API

The host microcomputer communicates with the R-IN32M3 Module via an API function to control the R-
IN32M3 Module provided by uGOAL. The APIs are categorized by protocol, and for more information, see
“R-IN32M3 Module (RY9012A0) User's Manual Software (R17US0002ED****)”.
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4.2 Logging
In this sample software, the function to output log message for debug is prohibited due to the memory
allocation limitation of RL/78G14.
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4.3 |IP Address Setting

This chapter describes how to set the IP address of R-IN32M3 Module.

The IP address of the R-IN32M3 Module is set according to the GOAL_ID_NET (12) configuration stored in
the internal nonvolatile memory at startup. It is also possible to set the IP address from the host CPU by

calling goal_maNetIpSet().

In the default setting in the sample applications of "01_pnio", "02_eip", "04_pnio_large" and "05_eip_large",
the IP address is set by the configurations stored inside (Configured IP). Defining the macro of
"GOAL_CONFIG_STATIC_IP" in the program enables to set arbitrary IP address (Static IP).

Table 4-1 IP Configuration (GOAL_ID_NET)

Variable Name Variable ID Type Max. Description
Size
IP 0 GOAL_CM_IPV4 4 IP address of first interface
NETMASK 1 GOAL_CM_IPV4 4 NETMASK of first interface
GW 2 GOAL_CM_IPV4 4 GATEWAY of first interface
VALID 3 GOAL_CM_UINTS8 1 Validity of IP address:
0, Stored IP address is not valid,
interface settings originate from
network stack of system
1, Stored IP address is valid, will be
applied to interface at start of device
DHCP_ENABLED 4 GOAL_CM_UINT8 1 DHCP enable:
0, DHCP disabled
1, DHCP enabled

Please note that VALID needs to be set "1" to activate IP address configurations stored in nonvolatile
memory. By executing the "goal_maNetipSet ()" API, configurations of IP, NETMASK, and GW are stored in
the nonvolatile memory, and whether to save the VALID setting can be specified by the last argument,
flgTemp. (GOAL_FALSE: Update VALID settings, GOAL_TRUE: not updated)

uint32_t addrlp,

NookrwdN =~

uint32_t addrMask,
uint32_t addrGw,
GOAL_BOOL_T flgTemp

GOAL_STATUS_T goal_maNetIpSet(
GOAL_MA_NET_T *pNetHdI,

/**< pointer to store NET handler */
/**< |P address */

/**< subnet mask */

[**< gateway */

/**< temporary IP config flag */

Also, DHCP mode is enabled by setting the "DHCP_ENABLED" in GOAL_ID_NET (12) to 1 or call the API
of goal eipCfgDhcpOn() for EtherNet/IP. In the sample software of 02_eip, DHCP is enabled by defining a
"GOAL_CONFIG_ENABLE_DHCP" macro as "1" in the program.
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Table 4-2 provides a list of how to set up an IP address.

Table 4-2 IP address setting list

Methods Descriptions

Configured IP - Use the value held in the non-volatile memory of R-IN32M3 module
- The value can be changed using the Management Tool. For more information, see "R-IN32M3 Module
(RY9012A0) Management Tool Instruction Guide (R30ANO390EJ****)”".

- This method is used as the default setting for “01_pnio”, “02_eip”, “04_pnio_large” and “05_eip_large” sample
application of this sample.

Static IP - Mainly used for evaluation.
- The changed value is hold in the non-volatile memory of R-IN32M3 Module.

- The value can be changed with “01_pnio”, “02_eip”, “04_pnio_large” and “05_eip_large” sample application of
this sample. By defining “GOAL_CONFIG_STATIC_IP” macro in the program with 1, any IP address can be set.

DHCP - It is possible to change enable / disable by using Management Tool.

- It is also possible to change using "02_eip" and “05_eip_large” sample application of this sample software, the
default value is disable. By defining “GOAL_CONFIG_ENABLE_DHCP” macro in the program with 1, DHCP
become enable.

- If DHCP is enabled and there is no DHCP server on the network, the value held in the non-volatile memory of
R-IN32M3 Module will be used.
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4.4 Board Stand-alone Operation

The emulator is placed in the forced reset state by short-circuiting EJ1 header (Emulator reset header) on
RL78/G14 Fast Prototyping Board. This allows stand-alone operation of the RL78/G14 independently of
control by the IDE (ex: e2studio) while the IDE is applying a forcible reset(only through-holes are provided,;
an actual header component is not mounted).

For details, refer to “RL78/G14 Fast Prototyping Board User's Manual” (R20UT4573EJ****).

it
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Figure 4-1 EJ1 header
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.
1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.
2. Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins
in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the

level at which resetting is specified.
3. Input of signal during power-off state

Do not input signals or an 1/0 pull-up power supply while the device is powered off. The current injection that results from input of such a signal or /0
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal

elements. Follow the guideline for input signal during power-off state as described in your product documentation.
4. Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal

become possible.
5. Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.
6. Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between Vi
(Max.) and Vin (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the

input level is fixed, and also in the transition period when the input level passes through the area between ViL (Max.) and Vi (Min.).
7. Prohibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these

addresses as the correct operation of the LSl is not guaranteed.
8. Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms
of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product.



Notice

1.

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use
of these circuits, software, or information.
Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights,
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics
or others.
You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for
each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics
disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product
that is inconsistent with any Renesas Electronics data sheet, user's manual or other Renesas Electronics document.
When using Renesas Electronics products, refer to the latest product information (data sheets, user's manuals, application notes, “General Notes for
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such
specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are
responsible for evaluating the safety of the final products or systems manufactured by you.
Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.
Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.

10. ltis the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or

transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.

11. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas

Electronics products.

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled
subsidiaries.
(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.
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